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Safety Warning: 

 
The equipment described in this document uses a Class 2 laser.  Under no account should anyone look directly into 
the laser beam or the laser beam exit aperture, irreversible damage to the eye may occur.  The laser should not be 
operated when there are personnel in the imager’s field of view. 
 
Caution – use of controls or adjustments or performance of procedures other than those specified in this document 
may result in hazardous laser radiation exposure. 
 
 

InfraRed Integrated Systems Ltd 
Park Circle, Tithe Barn Way 

Swan Valley 
Northampton 

NN4 9BG 
Tel: (01604) 594 200 
Fax: (01604) 594 210 

Email: sales@irisys.co.uk  

Class 2 laser product.  
Complies with IEC/EN 60825-1 
(2001). 
 
Conforms to USA 21 CFR 1040.10 
and 1040.11 except for deviations 
pursuant to laser notice No. 50 dated 
July 26th 2001.  
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1 Introduction  
 

This user manual describes the operation of the IRI 4010 multi-purpose infrared thermal imager and its 
associated software and accessories.  
 

2 Getting Started 
 

2.1 Unpacking 
 
After unpacking the IRI 4010 carrying case, you will find the standard items as shown in Figure 1.     
 
 

 

 
Figure 1: Contents of the IRI 4010 Multi-Purpose Thermal Imager 

 
Inspect all the items.  If any item is damaged or missing, please notify your dealer immediately. 
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2.2 Powering the IRI 4010 
 
The IRI 4010 thermal imager operates with a rechargeable battery, or from AC mains power.   
 
2.2.1 Using Battery Power – Inserting the Battery 
 

1. Open up the battery compartment on the bottom of the IRI 4010 thermal imager by sliding the 
battery cover off as indicated in Figure 2. 

2. Insert the rechargeable battery as shown below. 
3. Replace the battery cover.  
4. The above method also applies to replacing the battery, but make sure the IRI 4010 is switched off 

before removing the battery. 
 

    
 
 

 
Figure 2: Inserting the Rechargeable Battery. 

NOTES: 
• The rechargeable battery will power the IRI 4010 thermal imager for approximately 4 hours.  
• The battery indicator appears on the screen when the imager is switched on. It has the following four stages and each 

stage corresponds to approximately one hour of operation. 
 

 
 

 
 

Figure 3: Battery Indicator Levels. 

� CAUTION:  If the IRI 4010’s battery indicator flashes, the battery power is running low and it needs to be 
charged or replaced within 10 minutes.  

 
2.2.2 Using AC Mains Power  

 
1. Make sure the thermal imager is turned off. 
2. Connect the provided 12V power supply into the socket on the side of the IRI 4010 imager; see 

Figure 4. 
3. Attach the appropriate supplied regional adapter to the power supply. 
4. Plug the power supply into a mains socket.  
5. Switch on the thermal imager. 

 
� CAUTION: When using AC mains, use only the power supply included with the IRI 4010.  Using other power 

supplies may damage the IRI 4010 Thermal Imager. 
 
NOTE:  
• The mains power supply included with the IRI 4010 is for powering the IRI 4010; it will also recharge the battery 

(see Section 2.2.3). 

Replace Battery Cover Remove Battery Cover Insert Battery 

4 hours 3 hours 2 hours 1 hour 
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2.2.3 Battery Charging 
 

• The IRI 4010’s battery can be charged in the imager by inserting the included 12V power supply into 
the DC socket under the cover on the side of the IRI 4010 imager; see Figure 4. It takes 
approximately 4 hours to fully charge a fully depleted battery if the imager is switched off.  Charging 
the battery with the imager switched on takes longer. 

 

                  

Figure 4: Connecting the Mains AC Power Supply 

 

3 Operating the IRI 4010 Thermal Imager 
 

3.1  Hardware 
 
The IRI 4010 system is designed for use as a handheld thermal imager. Thermal images stored on the 
supplied memory card can be transferred to a PC or laptop computer using the supplied memory card reader. 
PC software is supplied for viewing and analysis of saved thermal images. 

 

 

 
Figure 5: The IRI 4010 Hardware. 

Safety notice:  The laser used in this device is designated Class 2.    
Under no circumstances should personnel look straight into the laser. 

Lens 

Laser Pointer 
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Battery 
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Laser Pointer 
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Slots (see Figure 4). 
 

Lens Cap 
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3.2 Switching on the IRI 4010 
 
 

 
 

Figure 6: Switching on the IRI 4010 

 

3.3 Information Splash Screen 
 
The IRI 4010’s splash screen appears for approximately 20 seconds when the imager is switched on. It 
displays the time and date so the user can check that any images saved will be recorded with the correct time 
and date. The time and date must be manually set (see Section 3.4.7.4). 
 
 

 
 

Figure 7: Splash Screen 

 
 
 
 
 
 
 
 
 

• The IRI 4010 features an On/Off power 
button above the display.  The IRI 4010 is 
switched on and off by holding the power 
button down for more than one second.  

 
• The IRI 4010 takes approximately twenty 

seconds to become operational. During this 
time a number of audible clicks will be heard. 
This is normal as it is part of the calibration 
procedure. After start-up these clicks 
continue, but become much less frequent. 

 
• For best measurement results the imager 

should be switched on at least 5 minutes 
before use. 
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3.4 Using the IRI 4010 Thermal Imager 
 
3.4.1 Focusing 
 
 
 

   
    
 
 
 

                              Figure 8: Focusing 

.  
 
3.4.2 Screen Display Items 
 
 
 

 

 

Figure 9: Screen Display Items 

 
� CAUTION: The calibrated temperature output is the figure adjacent to the cursor identifier; the temperature 

scale and display colours are indicators only.  
 
 
 

Scene emissivity 

The centre green 
circle to which the 
laser pointer is 
aligned at a 
distance of 3m. 
 

The  and  shaped 
temperature 
measurement cursors 
(called SP+ and SPX) 
and their temperature 
measurement values, and 
their temperature 
difference value (∆). 

Battery life indicator. Temperature 
units (˚C). 

Temperature scale 
with the maximum 
and minimum 
values of the span. 

Four hot button labels. 

If the imager is not focused, the image quality will be poor and temperature 
measurements will not be accurate.  
 
Rotating the lens in a clockwise direction (from front view) focuses the imager at 
longer distances up to infinity. Rotating the lens in the opposite direction focuses 
the imager at shorter distances down to a minimum of 30 cm. 
 
Rotate the lens until the image has the best definition, and has the sharpest contrast 
at object edges. 
 

    

Focused 
54°C measured. 

Not focused 
46°C measured. 
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3.4.3 Buttons 
 
Operation of the IRISYS 4010 imager application is by means of the 4 hot buttons, the 4 directional buttons, 
the menu button and the laser button (see Figure 10).  
 

• The hot buttons are mainly used to give quick control of:  
 

1. zoom function,  
2. image capture,  
3. measurement cursor selection  
4. auto/manual modes.  

 
It should be noted that the hot button functions change in different modes of operation. See Section 3.4.4 for 
more information. 
 

• The directional buttons are used to: 
 

1. move the position of the measurement cursors,  
2. adjust the level, span, brightness and contrast , 
3. navigate around the menus.  

 
See Section 3.4.5 for more information about the directional buttons and see Section 3.4.6.1 for definitions 
of level and span, and Section 3.4.9.1 for definitions of brightness and contrast. 
 
• The menu button opens the menus. See Section 3.4.7 for more information. 

 
• The laser button must be held down to turn the laser on. See Section 3.4.8 for more information. 

 
               

 
 

 

 

 

                 

Figure 10: Buttons 

Power Button 

Hot Buttons 

Menu Button 

Directional Buttons Laser Button 

Directional Buttons 
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3.4.4 IRI 4010 Hot Button Operation 
 
This section describes some of the basic functions of the IRI 4010.  The IRI 4010’s hot buttons are labelled 1 
to 4 from left to right for the purposes of this user manual. Their function is displayed as hot button labels on 
the IRI 4010’s display. Their labels can change in different modes of operation.  
 

 

Figure 11: Hot Buttons 

3.4.4.1 Hot Button 1 – Zoom 
 
This hot button toggles the zoom feature between off (X1) and on (X2). When zoom X2 is selected the central 
region of the thermal image expands to fill the display as in Figure 12, and the hot button label displays “X2”.  
 

                        

Figure 12: Zoom Function 
 

3.4.4.2 Hot Button 2 – Freeze/Save 
 
Hot button 2 freezes the live thermal image. It is possible to edit the image in freeze mode before saving it. 
Pressing hot button 2 again saves the image as an image.iri file to the SD card, whilst pressing hot button 1 
instead rejects the image. The file saving takes a few seconds, and the file name is given a sequential number. 
See Section 5.3.1.1.4 for how to save an image direct to a PC via the USB cable. 
 

3.4.4.3 Hot Button 3 - Direction Buttons Control. 
 
Hot button 3 selects either of the temperature measurement cursors (SP+ or SPX), or either L-S (temperature 
level and span) when in manual mode or B-C (thermal image brightness & contrast) when in auto mode. The 
4 direction buttons are then used to adjust the position of the selected cursor, the level & span, or the 
brightness & contrast depending on which mode is selected. Note that SPX must be enabled in the 
Measurement Settings menu, and that the B-C control is an advanced user function that must be enabled 
before use in the Camera Settings menu.  
 

3.4.4.4 Hot Button 4 – Auto / Manual 
 
This hot button toggles between auto and manual mode. In auto mode, the imager continually adjusts the level 
and span to achieve the optimum image. In manual mode it is possible to manually control the level and span 
to produce the image to your requirements. See Section 3.4.6.1 for definitions of level and span, and Section 
3.4.9.1 for definitions of brightness and contrast. The preset brightness and contrast of the auto mode can be 
adjusted to suit your preferences (See Section 3.4.9.1). 
 

1 

2 3 

4 

X2 X1 
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3.4.5 Directional Buttons 
 
The directional buttons (up, down. left & right – see Figure 13) are used for three different functions.  
 

1. If hot button 3 is set to either SP+ or SPX, the directional buttons control the position of the 
selected temperature cursor. (Selection displayed above hot button 3). 

2. If hot button 3 is set to L-S, “up” and “down” control the manual mode’s image temperature level, 
and “left” and “right” control the temperature span. See Section 3.4.6.1 for details. If hot button 3 
is set to B-C, “up” and “down” control the auto mode’s target image thermal brightness, and “left” 
and “right” control the target thermal contrast. See Section 3.4.9.1 for details. 

3. If the menu is displayed, the directional buttons control the movement of the highlighted cursor and 
adjustment of the highlighted option (see Section 3.4.7). 

 

 

Figure 13: Directional Buttons 

3.4.6 Image Adjustment 
 

3.4.6.1 Level and Span Definitions 
 
When hot button 4 is set to manual the IRI 4010’s image settings can be manually controlled by adjusting the 
level and span. When hot button 3 shows L-S, the “right” and “left” buttons respectively will increase and 
decrease the span of the image (4˚C in the example in Figure 14). The “up” and “down” buttons will increase 
and decrease the thermal level of the image (29˚C in the example in Figure 14). 
 

 

                     
          Figure 14: Level and Span 

 
The IRI 4010’s image settings are fully automatic when hot button 4 is set to auto. The auto mode 
automatically adjusts the level and span to display a presentable image.  
 

Level = (Max + Min)/2 = 29˚C 
 

Span = Max – Min = 4˚C 

Right 

Down 

Left 

Up 
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3.4.7 Menu Operation and Functions 
 
The main menu structure is opened by pressing the menu button in the centre of the directional buttons.  
 

 

Figure 15: Menu Button 

There are four sub-menus, which contain the functions listed in Table 1. 
 
Measurement Settings Camera Settings Image Browser  Clock/Calendar 
    
Emissivity  Colour Palette View Year 
Reflected Temperature Auto Power Delete Month 
Spot X  Factory Settings  Day 
Temperature Units Image Only  Hour 
Area B - C  Minute 
 Cursor Reset  Date Format 
   Time Format 

Table 1: Menu Functions 

The menu functions are selected by moving the highlighted cursor using the up and down directional buttons. 
Menu items are edited using hot buttons 2 & 3 which are labelled + and -. Hot button 1 is always available to 
take you “back” one menu sub-level, whilst hot button 4 is always available to “exit” the menus completely. 
Figure 16 shows an example screenshot from the Measurement Settings menu, with the highlighted cursor on 
the emissivity adjustor.  

 

Figure 16: Menu Operation 

3.4.7.1 Measurement Settings 
 

• Emissivity – The user can select the emissivity for the material being imaged.  To achieve 
correct temperature measurement the emissivity value must be set correctly. An emissivity 
lookup table is included in Section 6. 

 
NOTE:  Caution should be observed in using the emissivity control – the user should explore 

the effect on the observed temperature of an object when different emissivities are 
selected.  Low values of emissivity should be used only with extreme caution as large 
errors in temperature readings may be obtained with only small errors in emissivity. 
Care should also be taken to avoid reflections from hot/cold objects in the vicinity. 
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• Reflected T – When the emissivity is set to values less than 1.0, measurement accuracy can be 
further improved by setting the reflected temperature compensation. The reflected temperature is 
the temperature being “seen” by the object being imaged. The value entered must be within the 
range -20ºC to 200ºC or equivalent in ˚F or K. 

 
• Spot X - Toggle the second temperature cursor (SPX) display on/off the screen. When SPX is 

displayed the temperature difference (∆) between SP+ and SPX is also displayed. 
 

• Area – This removes the temperature measurement cursors from the image, and instead displays 
a small rectangle in the centre of the image. The cursor measurement readout changes to display 
the maximum and the minimum temperature within the rectangle. When a saved image is 
browsed in area analysis mode, the average temperature for the rectangle ( x ̄) is also displayed. 

 
• Temperature Units – Select between degrees Celsius, degrees Fahrenheit and Kelvin. 
 

3.4.7.2 Camera Settings 
 

• Colour Palette – The user can select one of four possible colour options. They are Rainbow, 
Ironbow, Greyscale (monochrome) or HC Rainbow (high contrast). 

 
• Auto Power – Turns the imager off if it has been left on without a button press for 20 minutes. 

 
• Factory Settings – For the convenience of the user, many settings are persistent, i.e. the settings 

and values are remembered when the IRI 4010 is switched off. Selecting the factory settings 
function  restores the imager to its factory default settings. 

 
• Image only - This option displays the image and the hot button labels only. 

 
• Brightness & Contrast – This option selects whether the advanced user function of brightness 

and contrast control is available on hotkey 3 when in auto mode (see Section 3.4.9.1). 
 

• Cursor Reset – Select this option to restore the cursor (or 2 cursors) to their default positions. 
 

3.4.7.3 Image Browser Menu 
 

• This browser shows a list of file numbers found on the SD memory card, starting with the most 
recent image. It is possible to scroll through the list and choose to view images or to delete 
image files.  

 
3.4.7.4 Clock/Calendar Settings 

 
• Set Clock – The clock can be set so images are saved with the time and date of image capture. 
 
• Date Format – choose between dd/mm/yy or mm/dd/yy. 
 
• Time Format – 12 Hour / 24 Hour clock  
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3.4.8 Using the Laser Pointer 
 
When the IRI 4010 is switched ‘ON’, the laser may be activated by pressing and holding down the red laser 
button. 
 

 

Figure 17: Laser Pointer 

 
3.4.9 Advanced User Functions 
 

3.4.9.1 Brightness & Contrast Definitions 
 
The thermal brightness is the colour at the centre of the colour scale, (the default thermal brightness for the 
rainbow colour palette is a yellow/green colour see Figure 18). Note that the brightness of the image does not 
refer to the brightness of the screen. For a greyscale image, brighter means whiter, and for a rainbow image, 
yellow is brighter than blue, and red is brighter than yellow.  The contrast is the amount of the colour bar that 
the image uses, and it uses the whole colour bar by default. 
 

 
 

Figure 18: Brightness & Contrast Definitions 

 
The target thermal brightness and contrast of the auto mode can be manually set when B – C is toggled to 
“ON” in the camera settings menu. This enables hot button 3 to be toggled to B-C when the imager is in auto 
mode. In this case the “right” and “left” buttons will increase and decrease the contrast of the image. The “up” 
and “down” buttons will increase and decrease the thermal brightness of the image.  

Laser Button 

The laser pointer is used to illuminate and identify features in the image. The 
laser pointer illuminates the area of the scene that coincides with the green 
circle indicator on the display – see Figure 9.  
 
NOTE:   The laser is aligned to objects at a distance of 3m from the front of 

the imager. 

Brightness = (Centre of colour bar) = Yellow/Green by default 
 

Contrast = (Amount of colour bar) = Whole colour bar by default 
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Edit the Contrast 

 

 
Edit the Brightness 

 
 

Default contrast 

  
 

 
Default brightness 

  

 
Increasing the contrast uses more of the outer colours 

of the colour palette i.e. black and white in the 
rainbow example. 

  
 

 
Increasing the thermal brightness uses more of the 

upper half of the colour bar. 
 

  

 
Reducing the contrast uses less of the outer colours 
of the colour palette, and uses more of the central 

colours i.e. green and yellow in the rainbow example. 
 

   
 

 
Decreasing the thermal brightness uses more of the 
lower half. See the examples in Figure 18 for more 

information. 
 

  
 

                   

Figure 19: These 6 figures show the effect of increasing and decreasing the auto mode’s brightness and 
contrast. 

 
The practical advantage of this is that the user can completely control the appearance of the image without 
having to adjust the level and span manually when viewing different scene temperatures. 
 

NOTE: The brightness and contrast can be reset back to the defaults by pressing hot button 4 to 
manual mode, and then hot button 4 again back to auto mode. 
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3.5 Technical 
 
3.5.1 Field Of View  
 
The IRI 4010 has a 20˚ x 15˚ Field of View, and a 160 x 120 (19200) pixel detector. 
 

 

 
Figure 20: Field of View 

 
 
 

 

Figure 21: 19200 Pixel Array 

 
 
 
 

120 pixels 

160 pixels 
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4 Thermal Image Transfer from IRI 4010 to a PC 
 

4.1 SD Card 
 
The Secure Digital (SD) memory card is the IRI 4010’s storage device for thermal images. This is also used 
to transfer thermal images to a PC when used with the SD card reader. Note that the imager will not be able to 
save thermal images without the SD card installed. 
 

1. Save thermal images onto the SD card as described in Section 3.4.4.2.  
2. Remove the SD card.  
3. Slot the SD card into the SD/MMC slot on the USB SD card reader supplied, making sure of the 

correct orientation. 
 

       

Figure 22: Inserting the SD card. 

 
4. Insert the USB connector of the SD card reader into a USB port on the Windows 2000 / XP PC, 

using the extender USB cable if required. 
5. Follow the card reader’s installation instructions if prompted by Windows. 
6. Either open My Computer and copy the .iri files from the SD card to the PC (recommended), or 

leave the SD card in place whilst the “IRISYS 4000 Series Imager” PC software is running and open 
the files directly from the SD card. 

 
NOTE: Image files must retain their file name (TIXXXXXX.iri). If they are renamed on the PC, they              

will no longer be readable by the imager. 
 

4.2 USB Cable 
 
A live thermal image can be saved directly to a PC using the USB cable provided connected between a PC’s 
USB port, and the imager’s USB socket (see Figure 23). The “IRISYS 4000 Series Imager” PC software must 
be installed onto the Windows 2000 / XP PC before making this connection. See Section 5.3 for more 
information. 

 

Figure 23: Slots and Sockets 

USB Socket, for 
connecting to a PC 
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5 Using the IRI 4010 Thermal Imager with a PC  
 

5.1 PC Requirements 
 
The PC should be IBM compatible running MS Windows XP or 2000, with a CD drive, and a USB port or an 
SD card reader. The “IRISYS 4000 Series Imager” application can be used for analysis of images previously 
saved onto an IRI 4010 SD card, or for downloading a live thermal image from the IRI 4010 via a USB cable. 
 

5.2 Installation of Software onto PC 
 
The software is supplied on a mini CD-Rom. 
 

1. Insert the supplied mini CD-Rom into the PC’s CD-Drive.   
2. Double click on ‘My Computer’ and then on the CD-Drive.  
3. Double click on ‘4000 PC Setup.exe’. 
4. Follow the on screen prompts to complete the installation. 

 
NOTE: 
• The IRISYS 4000 Series Imager software will by default be installed into the following path:   

 
C:\Program Files\IRISYS\IRISYS 4000 Series Imager 

 
• The above path and name can be changed during the installation, but it is advisable to leave it as the 

default.  The installation will also put a ‘Shortcut Icon’ onto your PC’s desktop to allow quick and easy 
start-up of the software. 

 

5.3 Operating “IRISYS 4000 Series Imager” PC Software 
 
Launch the IRISYS 4000 Series Imager program from the Desktop icon,  
 

 

Figure 24: Desktop Icon 

 
or from:  
 

� START/PROGRAMS/IRISYS/IRISYS 4000 Series Imager 
 
Alternatively it is possible to run the program by using Windows Explorer to find .iri files on your PC and 
then double-clicking an .iri file icon: 
 

 

Figure 25: .Iri File Icon 

The application executes and it looks like Figure 26, with the options window visible, and with empty frames 
for the image, colour bar and thermal histogram. The application window includes the file name if the file has 
been saved; otherwise it reads “Untitled”. 
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Figure 26: Application Window 

5.3.1 Menus and Toolbar 
 
The menu includes familiar Windows menu items such as “File”, “Edit”, “View”, Tools” and “Help”.  
 

 

Figure 27: The Menu 

5.3.1.1 Menus 
 
5.3.1.1.1 File 
 
The File menu contains the following features: 

• Open 
• Save 
• Save As… 
• Revert 
• Excel Output… 
• Recent Files 
• Exit 
 

1)  Open - Uses Windows Explorer (see Figure 28) to open an iri file from your computer. 
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Figure 28: Windows Explorer 

The iri files can be previewed in any of the five Windows explorer views: thumbnail, tile, icon, list or details, 
by selecting the “View” button in Windows explorer (shown in Figures 28 and 29). 
 

 

Figure 29: View Selector 

After an image has been opened, the application window looks similar to figure 30 below. The four main 
components of the application window are the options window, the image, the colour bar and the thermal 
histogram. Overlaid on the histogram is the movable span selector which adjusts the level and span of the 
thermal image. The span selector can be moved by clicking in the middle of the histogram and dragging left 
or right. The span can be increased and decreased by clicking towards the ends of the span selector (where the 
max and min values of the span are displayed) and dragging left or right. The span can be automatically reset 
by double-clicking in the middle of the span selector. 
 

 

Figure 30: Application Window 

Thermal 
Histogram 

Options 
Window 

Image 

Colour Bar 
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2)  Save – saves the iri file with the same name it had previously. If it was previously unsaved, the Save As… 
window appears. 
 
3)  Save As… – images are saved using a similar window to the “Open” window in Figure 28, but a file name 
must be entered. 
 
4) Revert – restores an image file back to its last saved state. 
 
5)  Excel Output… - save a 160 x 120 array of temperature data (assuming emissivity = 1) in comma 
separated variable format for use with Microsoft Excel and other spreadsheet applications. 
 
6)  Recent Files – a list of recently opened iri files appears here for easy selection. 
 
7)  Exit – closes the IRISYS 4000 Series Imager application. 
 
5.3.1.1.2 Edit 
 
The Edit  menu contains the following features: 

• Copy  
• Copy to Bitmap 

 
1)  Copy - This copies a screen capture of the application window or the thermal image into the Windows 
clipboard. This picture can then be pasted into a picture editor or Microsoft office document. 
 
2)  Copy to Bitmap – This saves a screen capture of the application window or the thermal image as a bitmap 
image using a dialogue box similar to Figure 28 above. 
 
5.3.1.1.3 View 
 
The View menu enables the following features, most of which are also available on the toolbar: 

• Toolbar 
• Status Bar 
• Measurement Cursor List 
• Measurement Cursors 
• Hot & Cold Cursors 
• Area Select 
• Blue Isotherm 
• Red Isotherm 
• Profiles 
• Options 

 
1)  Toolbar – This toggles the display of the icon toolbar below.  
 

 

Figure 31: Toolbar 

 
2)  Status Bar – This toggles the display of the status bar, which includes the temperature value and pixel 
position of the pixel under the mouse cursor when the mouse is over the image. It also displays the difference 
between the midpoints of the isotherms if both the isotherms are enabled. 
 
 

 

Figure 32: Status Bar 
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3).    Measurement Cursor List - This toggles the display of the measurement cursors list shown in Figure 
33, which includes the spot measurement, pixel position, and the difference between measurement cursors 1 
and 2. It also displays the hottest and coldest measurements in the scene, their difference, and the average 
temperature for the image. Also shown are the maximum, minimum and average temperatures for the area 
analysis box (if selected in the view menu). 
 

 
 

Figure 33: Measurement Cursor List 

Measurement cursors are added to the image by double-clicking in the location that the cursor is required. 
When the mouse cursor is moved over a measurement cursor the mouse cursor appears as a hand. When this 
happens the measurement cursors can be moved around by dragging them, and can be removed by double 
clicking them. 
 

4)    Measurement Cursors – This toggles the display of the measurement cursors on the thermal image. 
This does not delete the cursors; it temporarily hides them. 
 

 

Figure 34: A Measurement Cursor 

 

5)    Hot & Cold Spot Cursors – This toggles cursors over the hottest and coldest measurements in the 
thermal image. The values of these (and the difference) are shown in the measurement cursors list. 
 

 

Figure 35: Hotspot Cursor 
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6)   Area Select – This toggles a rectangular area over the centre of the image. The maximum, minimum 
and average temperatures for this area are then displayed in the measurement cursors list, allowing 
measurement by area analysis. The area’s position can be moved in conjunction with the zoom & pan control 
(see Figure 36). For more information on the zoom & pan control see Figure 40. 
 

 

Figure 36: Area Select 

 

7 & 8)   Isotherms – This toggles the two isotherms which can be used to highlight areas of the same 
temperature in the image. A red and/or blue semi transparent block appears on the histogram which can be 
moved and adjusted in the same way as the image span selector. Every object in the image with a temperature 
within the range of the isotherms appears either red or blue in the image. Use of the greyscale colour palette is 
recommended whilst using the isotherms. 
 

 
 

Figure 37: Dual Isotherms 
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9)    Profiles – This toggles the 2D profile view which is used to display a graphical representation of the 
temperature values along the selected vertical and horizontal lines. 
 

 
 

Figure 38: 2D Profiles 

 
To the left of the image is a thermal intensity plot which corresponds to the vertical cross section through the 
image. Below the image is a similar plot that corresponds to the horizontal cross section. The cross sections 
can be moved by dragging them either independently or by dragging the intersection.  The short green 
intensity plot lines on the thermal intensity plots can be moved to analyse temperatures in the plots. Double-
click an intensity plot line to make the corresponding cross section line-up with it.  
 

10)   Options – This toggles the display of the options window. The options window has four tabs across 
the top and it can be embedded in the application window or in a free-floating window, depending on whether 
or not “Dock Options” is ticked in the “Tools” menu. Click the tab labels to select each tab. 
 
 

 
 

Figure 39: Options Tab Labels 

The Display tab is shown below: 

Thermal 
Intensity Plots 
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Figure 40: Display Tab 

In the Display tab, it is possible to: 
 

• Adjust the span of the image manually (by typing) 
• Adjust the span of the image automatically 
• Select one of four colour palettes 
• Select whether to display the image at its original resolution or to interpolate the image to 320 x 240 

or 640 x 480 
• Select zoom factor from x1 to x4  
• Select which area of the image to zoom by dragging the green box in the pan control using a mouse 

 
The Cursors tab is shown below: 
 

 

Figure 41: Cursors Tab 

In the Cursors tab, it is possible to: 
 

• View the temperature values of the measurement cursors, and also their pixel numbers from the 
origin (bottom left of image) and the emissivity value associated with the cursors. 

• Delete cursors from the image by selecting them in the “name” column and clicking “remove”. 
Multiple cursors can be removed simultaneously by using the standard Windows selection methods 
with the Ctrl or Shift buttons. 
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The Settings tab is shown below: 
 

 

Figure 42: Settings Tab 

In the Settings tab, it is possible to: 
 

• Select ˚C, ˚F or K 
• Adjust the reflected temperature correction 
• Adjust the target object emissivity 
• Adjust the required capture time and date 
• Add comments to the image 

 
The Properties tab is shown below: 

 

 

Figure 43: Properties Tab 

This tab displays important file information. 
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5.3.1.1.4 Tools 
 
The Tools menu contains the following: 

• Imager Comms Config… 
• Capture From Imager… 
• Reset Isotherms 
• Dock Options… 

 

1)   Imager Comms Config… - This is used to transfer single images taken from the live image in the IRI 
4010 to a PC via a USB connection. The first time the imager is connected to a PC via USB, the USB drivers 
must be installed to the PC from the CD. 
 

1. Switch imager on   
2. connect USB cable to imager  
3. connect USB cable to PC  
4. the Windows XP/2000 “found new hardware wizard” will appear  
5. direct the wizard to the “USB Virtual Com Port” folder on the CD, and click “next” 

 
You may have to repeat parts 4 and 5 to install the second part of the 2-part USB driver. Once the drivers 
have been installed, select Imager Comms Config to open the window in Figure 44 below. Select the “USB 
Serial Port (COM X)” from the list, click “Test Port” and then click “OK”. 
 

 

Figure 44: Port Selection 

2)  Capture from imager… - After setting up the Imager Comms Config, select this to take a new image 
from the imager. The IRI 4010 imager must be switched on and connected via the USB cable provided to a 
USB port on your computer. The file transfer takes approximately 10 seconds. As always when taking an 
image, make sure the imager is correctly focused on the target. 
 
3) Reset Isotherms – This moves the two isotherms back to their default positions. The isotherms must be 
displayed to see the effect of this tool. 
 
4)  Dock Options – This selects whether to dock the Options dialog box into the application window or 
whether to have the Options in a free-floating window of its own. If the Options box is not displayed, this 
menu item will be disabled. 
 

   

Figure 45: Options Docked and Free-Floating 
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5.3.1.1.5 Help 
 
The Help menu gives the following information: 

• About 
 
1) About IRISYS 4000 Series Imager – This displays the IRISYS software version being used. 
 

 
 

Figure 46: Version Information 

5.3.1.2 Toolbar 
 
The Toolbar includes 12 icons; all of which have been covered in the menus. The icons are listed below.  
 

 

Figure 47: Toolbar 

 
1) Open    - See Section 5.3.1.1.1  
2) Save   - See Section 5.3.1.1.1   
3) Capture from Imager  - See Section 5.3.1.1.4  
4) View Options  - See Section 5.3.1.1.3 
5) Toggle Measurement Cursor list See Section 5.3.1.1.3  
6) Toggle Measurement Cursors - See Section 5.3.1.1.3  
7) Toggle Hot & Cold Cursors - See Section 5.3.1.1.3 
8) Toggle Area Select  - See Section 5.3.1.1.3 
9) Toggle Blue Isotherm  - See Section 5.3.1.1.3  
10) Toggle Red Isotherm  - See Section 5.3.1.1.3 
11) Toggle Profile Display - See Section 5.3.1.1.3 
12) About   - See Section 5.3.1.1.5 
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6 Emissivity Lookup Table 
 
Below is a list of approximate emissivity values for a range of materials for making more accurate 
temperature measurements.  
 

NOTE:  Emissivity values often vary with temperature and wavelength so this table is included as a 
guide only. 

 
1.000000 = Black body 
0.980000 = Carbon filed surface 
0.980000 = Frost crystals 
0.980000 = Skin human 
0.970000 = Slate 
0.960000 = Water distilled 
0.960000 = Ice smooth 
0.950000 = Soil saturated with water 
0.950000 = Carbon candle soot 
0.940000 = Glass polished plate 
0.940000 = Paint, oil 
0.930000 = Brick red 
0.930000 = Paper white bond 
0.920000 = Concrete 
0.920000 = Soil dry 
0.910000 = Plaster rough coat 
0.900000 = Wood planed oak 
0.900000 = Glazed earthenware 
0.890000 = Snow, granular 
0.880000 = Glazed Silica 
0.870000 = Cuprous Oxide at 38°C 
0.860000 = Emery Corundum 
0.850000 = Snow 
0.850000 = Stainless oxidized at 800°C 
0.840000 = Oxidised Iron at 500°C 
0.830000 = Cuprous Oxide at 260°C 
0.820000 = Snow, fine particles 
0.810000 = Brass, unoxidised 
0.800000 = Glass, convex D 

0.790000 = Steel oxidised 
0.780000 = Copper heavily oxidised 
0.770000 = Cotton cloth 
0.760000 = Sand 
0.750000 = Unglazed silica 
0.740000 = Oxidised iron at 100°C 
0.730000 = Coating No. C20A 
0.720000 = Basalt 
0.710000 = Graphitised carbon at 500°C 
0.700000 = Red Rust 
0.690000 = Iron sheet heavily rusted 
0.670000 = Water 
0.660000 = Black Loam 
0.650000 = White cement 
0.640000 = Iron cast oxidised 
0.630000 = Lead oxidised at 1100°F 
0.620000 = Zirconia on inconel 
0.610000 = Cu-Zn, brass oxidised 
0.580000 = Inconel sheet at 760°C 
0.560000 = Smooth white marble 
0.550000 = Al anodised chromic acid 
0.210000 = Iron cast polished 
0.200000 = Brass rubbed 80 grit emery 
0.160000 = Stainless steel 18-8 buffed 
0.090000 = Aluminium as received 
0.070000 = Steel polished 
0.050000 = Aluminium polished sheet 
0.050000 = Copper polished 
0.030000 = Brass highly polished 
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7 Customer Feedback 
 
If you have had any technical issues or feedback with regard to your IRI 4010 Multi-Purpose Thermal Imager, 
please complete the details below and send it back to IRISYS at the address on the front page of this manual.   
 
 
Name: 
 
 
Company Name and address: 
 
 
 
 
 
 
Contact Details: 
 
 
 
IRI 4010 Thermal Imager Serial Number: 
 
(This can be found printed under the “slots & sockets” cover) 
 
 
PC Software Version installed: 
 
Software version number can be found whilst software is running from: 
 
PC – Help/About IRISYS 4000 Series Imager 
 
Description of Technical Fault: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All brands and product names are acknowledged and may be trademarks or registered trademarks of their 
respective holders. 


